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About This Document

This deployment guide is intended for system administrators and engineers. It includes
instructions for installation and configuration of ABBYY Timeline 5.3 on Windows.
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Introducing ABBYY Timeline

ABBYY Timeline is a process intelligence platform comprising over 25 process analysis tools.
More than a mere process tracker, ABBYY Timeline will monitor all events within your company
in real time and build a detailed map of each process, all while maintaining the flow of your

business.

ABBYY Timeline employs an exciting new patent-pending approach to process intelligence
called Timeline Analysis which allows users to load events from a variety of systems and in
different formats which it then automatically organizes into its corresponding process instances
and allows them to be analyzed with a variety of visualization, discovery and query techniques.
ABBYY Timeline accepts event data from any number of systems of record and automatically
reconstructs the underlying business process logic behind the data. A variety of pre-built
analyses are ready to quantify your process performance, identify your process execution issues
and perform root cause analysis. The ABBYY Timeline platform also supports operational
monitoring through its continuous assessment of new event data to determine if any adverse
conditions occur and can immediately notify you or other business operations personnel so you

can act.

The ABBYY Timeline engine consumes data from a variety of sources to detect and present
detailed views of your business processes. This is often the same exact data being used today
for other simpler analyses. This new insight is delivered via a variety of new process and timeline
visualization tools developed to not only make these new insights easier to understand but also
to allow users to manipulate the information to gain a deeper understanding of those
processes. Users armed with this insight have concrete facts on which to take actions to improve
operational efficiency by promoting clearly superior best practices and eliminating costly

inefficiencies that previously went undetected.

Using advanced algorithms, ABBYY Timeline extracts and reads the time stamps used to record
specific events along your processes. The software then visually models these time stamps in
such a way that you can instantly identify deviations from an ideal process flow — to find the

root cause of a problem that may be costing your business money.

ABBYY Timeline is aimed for use by anyone involved in business process improvements of any
type of scale or nature.

© 2022 ABBYY Development Inc.
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ABBYY Timeline Components

Whether you use ABBYY Timeline via ABBYY's SAAS instance or installed on-premises the
recommended configuration of Timeline requires 3 key components.

1. The core ABBYY Timeline
It is either hosted by ABBYY or installed on-premises. There is no difference in

functionality whether Timeline is accessed via ABBYY's cloud instance or installed
locally.

2. The desktop ABBYY Recorder

It is only on-premises and includes Recorder, Recorder Log Viewer, and browser
extensions for Google Chrome, Mozilla Firefox and Microsoft Edge.

3. The central ABBYY Recording Service

It is only on-premises and includes database and website.

The purpose and functions of platform components are described in the table below.

Component Functions

ABBYY Recording Service ABBYY Recording Service collects user interaction logs from multiple
users over time and allows to submit obscured data into ABBYY

Timeline
ABBYY Recorder Captures individual users’ desktop sessions.
C_BBYY Recorder Log Allows user to view the logs recorded by the ABBYY Recorder.
iewer
For detailed information on usage of Log Viewer, see 'Recorder Log
Viewer Guide'.
ABBYY Timeline

Analyzes desktop user interaction data and seamlessly links it with
process details mined from system event data, so you can see where
repetitive and inefficient tasks are slowing your processes and
allocate resources in the right places to resolve them.

Getting Started

Ready to deploy? The instruction below walks you through deploying ABBYY Timeline system,
step-by-step.

© 2022 ABBYY Development Inc.
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Step 1.
system

Make sure your computers are ready for ABBYY Timeline

Before you begin installing ABBYY Timeline system:

1.

Step 2.

If you are

1.

Check the system requirements| 1
These requirements help you know whether your computers support ABBYY Timeline
components.

Apply the latest Windows and other programs updates.
These updates ensure that your computer has the latest security updates.

. Reboot.

The reboot ensures that any pending installs or updates don't hinder the ABBYY
Timeline components install.

Free up space.

Remove unneeded files and applications from your %SystemDrive%, as well as discs
that you intend to use, for example, to store the Timeline or Recording Service
databases.

If you intend to configure HTTPS, please visit the 'Using HTTPS &1 section.
Install ABBYY Recording Service

not going to use the Task Mining feature, skip this step.

Run the ABBYY.RecordingService.5.3.*.exe file and follow the on-screen instructions
in the Installation Wizard.
If you receive a User Account Control notice, choose Yes.

Specify the necessary network settings s

Make sure the Recording Service has been installed correctly by performing a health
check on Recording Servicel =1

Please refer to the 'Installing Recording Servicel »1 section for guidelines.

© 2022 ABBYY Development Inc.
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Step 3. Install ABBYY Timeline

If you are going to use Timeline in the cloud, please, skip this step.

Important. Recording Service and Timeline components must be installed on separate

computers.

1. Run the ABBYY-Timeline-5.3.*-installer.exe file and follow the on-screen
instructions in the Installation Wizard.
If you receive a User Account Control notice, choose Yes.

2. Specify the necessary network settings| ss1

3. Make sure the Timeline has been installed correctly by performing a health check on
Timeline[ 21

Please refer to the 'Installing ABBYY Timeline[ 20T section for guidelines.

Step 4. Establish the trust relationship between ABBYY Recording
Service and ABBYY Timeline

If you are not going to use the Task Mining feature, skip this step.

For interaction between Recording Service and Timeline, OAuth must be configuredmﬁ.

© 2022 ABBYY Development Inc.
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1. Register Recording Service as a client on the Timeline website and obtain credentials
(Client ID and Client Secret).

Please refer to the 'Registering a New Client on ABBYY Timeline websitel #1 section

for guidelines.

Register OAuth Client b 4

* Name

Recording Service

* App URL

https://recordingservice.abbyy.com

* Redirect URI
https://recordingservice.abbyy.com/api/auth/callback

Confidential client

Confidential clients are applications that are able to securely authenticate with the
authorization server, for example being able to keep their registered client secret safe.
Non-confidential (Public) clients are unable to use registered client secrets, such as
native applications. They are expected to authenticate with client ID and PKCE flow

Client logo

1. Change logo

Scopes

Read projects
Write projects
Read repositories

Write repositories

© 2022 ABBYY Development Inc.
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2. In the Recording Service website specify the Timeline authentication details using the

credentials you obtained in step 1.

Please refer to the 'Configuring connection setting in Recording Service[s'I section for
guidelines.

TIMELINE AUTHENTICATION LANGUAGE

Bl save
* Recording Service public URL
https://recordingservice.abbyy.com ﬂ

* Timeline URL

https.//mytimeline.com

* Client 1D
frsedsbcde3ns6Tidegmnid292 116Tfebecd5e

* Client secret

(i) Timeline Authentication Guide

1. TimelineURL should be the URI of your installed Timeline instance. If you haven't installed Timeline yet,
please do so now.

L In your running Timeline instance, create an account and after logging in
a. Navigate to Account Settings -+ OAuth + and click on "Register client™

b. Fill out the client registration form
i. App name can be anything

ii. App URL
https://recordingservice. abbyy.com rE’]
Click on the icon to copy this value and paste it to the client registration form in Timeline
iii. Redirect URI
https://recordingservice.abbyy.com/apifauth/callback rE’]

Click on the icon to copy this value and paste it to the client registration form in Timeline
iv. You can upload an optional Client Logo
v. Make sure to checkthe confidential client checkbox
vi. Make sure to only checkthe Read projects and Write projects checkboxes
vii. Click "Register client™
c Copy thevaluesof cClient I0 and client secret respectively to this screen

3. Click "Save™

Step 5. Install ABBYY Recorder on users' computers

If you are not going to use the Task Mining feature, skip this step.

Important. The user workstations installing the Recorder, and the server hosting the Recording
Service must all be members of the same Active Directory domain.

© 2022 ABBYY Development Inc.
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If you plan to record user activities who work using Windows RemoteApp and Citrix Workspace
App, install the Recorder on a terminal server.

ABBYY Recorder can be installed on the terminal server as if it was a workstation. It will log the
actions of users connecting to this server via a Citrix client or RDP.

1. Install the Recorder on the users' workstations using the method of your choice.

Please refer to the 'Installing Recorder{ ! section for guidelines.

2. Turn on Recorder extensions on the workstations.
Please refer to the 'How to Turn Recorder Chrome Extension onl «! section for
guidelines.

Now you have all the ABBYY Timeline system components installed, and you can start working
with it.

Step 6. Start working with Task Mining

After ABBYY Timeline system installation is complete, it must be configured.
1. Open the Recording Service website and configure settings.

a. Go to Settings > Timeline authentication and make sure the connection to
Timeline is established.

Please refer to the 'Administering' >'Using OAuth to Access Timeline' >

'Configuring connection setting in Recording Service[sT section for guidelines.

b. Go to Templates and click Default in the Template name column. Review and
modify the options if needed.
In the template, you can specify what data to register and how to process it. Please
refer to the 'How to Configure and Apply Templatel T section for guidelines.

c. Go to Recorders.
You will see the list of connected recorders that were installed in Server managed
mode. Installed in this mode, recorders are automatically added to the Recorders
list.

d. Select a recorder and click Start.
This starts recording all user's desktop events to log.

© 2022 ABBYY Development Inc.
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e. Go to Logs
All recorded events are collected into logs and available in the Logs tab.
Note. The logs may take some time to process. We recommend you wait a while
before starting to work with the logs.

f. Submit logs from Recording Service to Timeline

To upload logs to Timeline, perform the following steps:

i. Selectlogs and click Load to project.
Recording Service will redirect you to the Timeline authentication page.

ii. Enter your Timeline credentials (i.e. credentials specified during the Timeline
installation processl z) and click Allow in the access permission window.
This will enable Recording Service to upload logs into your account projects.

ABBYY Timeline

Project permissions

Read
B

Recording Service require access to your
account tam@abbyy.com

Manage permissions €

Deny [ Allow ]

iii. In the opened Project list windows go to Create project, enter the name for
your new Task Mining project and click Create to upload logs.

iv. All selected logs will be queued for upload.
Information about the upload process is displayed in the message box. You can
abort the upload by clicking Cancel in the message box.
Note. It is impossible to cancel the upload of logs that have already been
submitted to Timeline by the moment of cancellation. Such logs will be
available for work on the Timeline website.

© 2022 ABBYY Development Inc. 13
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v. After successful log import click on B4 and then on the project name to open
this project in Timeline.

2. Uploaded logs are available for cutting and transforming in the opened project.

© 2022 ABBYY Development Inc.
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System Requirements and Prerequisites

Important.

e Recording Service and Timeline must be installed on separate computers.

e The user workstations installing the Recorder component, and the server hosting the

Recording Service component must all be members of the same Active Directory

domain. Please refer to the "Configuring Active Directory Groups to Connect the
Recording Service with Recorders| 21" section for details.

¢ Recording Service performance may vary depending on the hardware configuration. If

you intend to use more than 20 Recorder instances, store PostgreSQL databases

partially or fully on the SSD for better performance. For details see "How to move

database tables with screenshots to a new hard disk| s1".

Timeline

Operating system

CPU
RAM

HDD

Browser
(to access the
ABBYY Timeline

website)

Additional

software

Microsoft® Windows Server® 2019 Version 1809 (OS Build 17763.2565) or
later

4 cores or more
16 GB or more

512 GB or more

Depends on the actual amount of data loaded into the application.
Production environment may require more disk space, depending on the

actual volume of data loaded into the application.

e Google Chrome 100 or later

e Microsoft Edge 100 or later

¢ Microsoft Windows Subsystem Linux
If this Windows feature is disabled, the ABBYY Timeline Setup will prompt
you to enable it. After that, you will need to restart your computer to

apply the changes.

© 2022 ABBYY Development Inc. 15
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e Redis 5 for Linux
ABBYY Timeline uses Redis for Linux therefore additional software is
needed. Please, download the following installation packages into the
same folder:

o Linux Ubuntu 20.04
(CanonicalGroupLimited.UbuntuonWindows_2004.2021.825.0.AppxBund
le)

o gcc-10-base_10.3.0-1ubuntul1_20.04_amd64
o libatomic1_10.3.0-Tubuntu1_20.04_amdé64.deb
e Microsoft .NET Framework 4.5*[ 1]
e PostgreSQL 12.%[ 18]
e NodelS 14.16.1%*| 1
o Python 3.8.10. (64-bit)*[ ]

e Microsoft Visual c++ 2015-2019 Redistributables (x64)i|_ﬁ'7
e GraphViz 2.49.0*[ )
e SMTP Server

ABBYY Timeline needs access to a running SMTP server to be able to send

verification emails, notifications, invitations, and alerts, etc.

Other To install ABBYY Timeline on Windows successfully, make sure a user you
requirements are installing under is able to set the PowerShell Execution Policy to

RemoteSigned. For details, see Installing Timeline| 20

Scaling guidelines

The exact calculation of necessary hardware requires multiple parameters such as data volume

and use patterns. However, the general guidelines could be defined as following:

e If the number of concurrent users is less than 10 and the data update frequency is one
per day or less, a single server should be sufficient.

© 2022 ABBYY Development Inc.
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e For more users or more frequent data updates, a separate server for DBMS is

recommended.

e For the fault-tolerant environment, use two identical servers and any standard load

balancer.

Recording Service

Operating system

Additional

software

Browsers
(to access the
Recording Service

website)

Hard disk

requirements

Other
requirements

Microsoft® Windows Server® 2019, 2022

e Microsoft® Internet Information Services (lIS) 8.5*[ 7]
e ASP.NET Core Hosting Bundle 6.0.4*[ 17)

o PostgreSQL v. 12 or later*[ 7]

Google Chrome 100 or later

Recording Service performance may vary depending on the hardware
configuration. If you intend to use more than 20 Recorder instances, store

PostgreSQL databases partially or fully on the SSD for better performance.

Important. Only the database table with screenshots is allowed to be

moved to the new hard disk.

For details see "How to move database tables with screenshots to a new
hard diskl ".

1. The Recording Service works with Timeline 5.3

2. Windows authentication is used to authorize the connection between
the Recording Service and the Recorder instances installed on users'
workstations. Configure Active Directory Groups you plan to use to
connect the Recording Service with Recorders in advance. Please refer to

the 'Configuring Active Directory Groups to Connect the Recording
Service with Recorders[ 21 section for guidelines.

* included with the Recording Service installer.

© 2022 ABBYY Development Inc.

17



ABBYY ® Timeline 5.3 - Deployment Guide

Hardware configuration example
If recording is done for 10 employees during 4 weeks (1 person generates approximately 5000
Ul events per day):

e Operating system: Windows Server 2019

CPU: 8 cores or more

RAM: 16 GB or more

Hard disk space: 256 GB HDD/SSD

Logs with screenshots require at least 200 GB

Recorder

Operating system | Microsoft® Windows 10 (x64), 11 (x64)

Microsoft® Windows Server® 2019

Additional Microsoft .NET Framework 4.6.2*[ 1]

software

Browser e Browser Google Chrome 100 or later

(to record user Important. The following versions are not supported:
activities)

o Google Chrome Portable

o Google Chrome Standalone for one user

o Google Chrome Standalone for multiple users
e Microsoft Edge 100 or later

e Mozilla Firefox 99 or later (Limited support. See Known Issuel 1 for
details)
Important. Mozilla Firefox ESR is not guaranteed to fully work.

© 2022 ABBYY Development Inc.
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Other 1. Recorder works with Recording Service that comes with Timeline 5.3.

requirements ' S ) '
2. Windows authentication is used to authorize the connection between

the Recording Service and the Recorder instances installed on users'
workstations. Configure Active Directory Groups you plan to use to
connect the Recording Service with Recorders in advance. Please refer to

the 'Configuring Active Directory Groups to Connect the Recording

Service with Recorders[ 1 section for guidelines.

* included with the Recorder installer.

© 2022 ABBYY Development Inc.
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Installation, Removal and Upgrade

This section provides instructions for installing the ABBYY Timeline components, upgrading, and

removing them from your computers.

ABBYY Timeline

This section contains information about installing and removing ABBYY Timeline.

Important. The ABBYY Timeline installer does not have a repair mode. Please do not
edit/delete anything in the installation folder unless you have received clear instructions on
what to do. In case you deleted something from the installation directory by accident, you will

have to uninstall, then re-install ABBYY Timeline.

If you are going to use ABBYY Timeline in the cloud, please skip this chapter.

Installing Timeline

Before you begin

1. Log in as a Windows administrator or start Timeline Setup with Run as
Administrator.
To perform all activities below, you must be a system administrator of the computer

on which Timeline is being installed.

2. Ensure the Execution Policy for PowerShell is set to RemoteSigned. To verify the

current settings for the execution policy:
a. Start Windows PowerShell with Run as Administrator

b. Use Set-ExecutionPolicy RemoteSigned to set the policy to RemoteSigned.
If the command was executed without errors, go to the Timeline installation
procedure by starting the Timeline installer with Run as Administrator.
If you get an access is denied error, you do not have the permissions to change the
execution policy. Please contact your system administrator to have your
permissions changed.

© 2022 ABBYY Development Inc.
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Interactive installation

Run the ABBYY-Timeline-<version> -installer.exe file, select the language to run the
Installation Wizard and follow the on-screen instructions.

The Installation Wizard will display a sequence of pages with detailed instructions for each
installation step. Use the Back and Next buttons to navigate the pages. To quit the Installation
Wizard at any stage, click Close.

1. License Agreement

Read and accept the license agreement.

2. Check and install prerequisites
Timeline Setup checks third-party applications that are required to configure and
operate ABBYY Timeline. Some of the applications you must download and install
manually. If your computer meets the system requirements, the steps described in this
paragraph will not display.

a. Enable Windows Features
If the Microsoft Windows Subsystem Linux feature is disabled, the Timeline
Setup will prompt you to enable it. After that, your computer will be restarted
automatically. Please save your work before continuing the installation. After
restarting, the Timeline installation will be auto-resumed. If it doesn't run

automatically, please run the ABBYY-Timeline-<version>-installer.exe file again.

b. Redis installation

i. Download the following installation packages into the same folder:
- Linux Ubuntu 20.04
(CanonicalGroupLimited.UbuntuonWindows_2004.2021.825.0.AppxBundle)

- gcc-10-base_10.3.0-1ubuntul1_20.04_amd64
- libatomic1_10.3.0-1Tubuntul_20.04_ amd64.deb

ii. Source Folder
Specify a folder where you renamed packages specified above.

iii. Ubuntu Installation Folder
Specify a folder where Ubuntu will be extracted to. The default folder is:
C\Program Files (x86)\Ubuntu

© 2022 ABBYY Development Inc.
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3.

Installation Folder
Select a destination folder where Timeline will be installed.
The default folder is: C:\Program Files\ABBYY Timeline

Select Database

Timeline needs access to PostgreSQL. You can install PostgreSQL on a computer along
with Timeline or a separate one.

If you already installed PostgreSQL on another computer, select Connect to existing
database. This option is useful if you install the program in a production environment
where the host machine is accessible from outside the corporate network. If you
prefer to keep Timeline and the database on the same machine, select Install local
database. This option is useful if you install the program for testing purposes.

Go to the next step to specify database connection settings.

Database Connection
Specify connection parameters to Timeline databases located on a local or remote
PostgreSQL.

a. If you selected Install local database, configure access to a local PostgreSQL
instance. To set up access to an existing PostgreSQL instance, go to step 5b
below( 21
Using the options specified in this clause, Timeline Setup creates the following
databases during the installation process:
timeline - the Admin database. It contains all information about users, their
activity, and projects.
timeline-log - the Log database. It contains detailed records of Timeline events
such as security, errors, and notifications.
timeline-000 - the User database. It contains information about user repositories.

i. PostgreSQL user and PostgreSQL password
Provide PostgreSQL superuser credentials. These will be used by the installation
program to create a database user for Timeline.

ii. PostgreSQL port
Specify TCP/IP port for PostgreSQL. By default, TCP/IP port 5432 is used. Make

sure that it is not being used by any other application. For more information,

see the Check TCP/IP port availability|_57'1 section.

iii. Data directory
Enter the path where the database needs to be installed.
The default path is: C:\Program Files\PostgreSQL\12
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b. Configure access to an existing PostgreSQL instance
If you selected Connect to existing database in step 4, this means PostgreSQL is
already installed on a remote or local server. To create and configure access to the
Timeline databases, specify connection parameters for the Admin, Log, and User
databases.
Note. If the Timeline databases already exist on the specified PostgreSQL server
and the PostgreSQL version is supported, the Review Database Configuration
step will open. Select Connect to the existing Timeline database if you want
ABBYY Timeline to connect to the detected database. Otherwise, select Reinstall
Timeline database tables and user. In this case, the installer will delete the
detected databases and install new ones.

i. PostgreSQL user and PostgreSQL password
Provide the credentials of PostgreSQL user who will own the Timeline

databases. For example, TimelineUser.

ii. PostgreSQL host
Specify the server name where PostgreSQL is installed. By default, localhost is
used.

iii. PostgreSQL port
Specify TCP/IP port for PostgreSQL. By default, TCP/IP port 5432 is used.

iv. Database name
A name must be given for each database:
timeline is the only valid name for the Admin database.
timeline-log or timeline_log is the only valid name for the Log database.
timeline-000 or timeline_000 is the only valid name for the User database.

v. If your PostgreSQL is configured with SSL support, select Use SSL for the
database connection.
If your PostgreSQL is configured with SSL support and a CA Root certificate file
is used, provide the full path to the CA Root certificate file.

6. Admin User Account
Create a first admin user account for ABBYY Timeline. Enter a valid email address
using an existing domain name that is configured to receive emails, for example,
user@domain.com, and a password. This will be the first user and the one that will
have access to the ABBYY Timeline website, where other users can be administered.

The password you specified must contain only English letters and digits from 0 to 9. It
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must be at least eight characters long, contain at least one uppercase letter, one

lowercase letter, and one number.

7. Mail Server Configuration
Configure the SMTP server access to allow Timeline sending out emails in several
features such as Alerting, User invitation, Email verification, etc. For example, during a
user registration process, a verification email message is sent to the user. The user
won't be able to use Timeline until he completes the instructions contained in the
message.
Provide general information to configure SMTP mail server and specify its security
options. To decide which options you have to select, please refer to the
documentation of your mail server. The server basic settings are set during

installation. You can change the SMTP Mail Server configuration after installation.

a. Mail server host
Enter server name where the SMTP mail server is installed.

b. Mail server port
Enter the SMTP mail server port number.

c. Mail server username and Mail server password
Enter the SMTP mail server access credentials. Keep these fields empty if your mail

server requires no authentication.

d. Email sender

Enter the e-mail sender address is used to fill the 'From' header field of e-mails.

e. Mail server security
Specify mail server security options. To decide which option you have to select,
refer to the documentation of your mail server. Mail server basic settings are set
during installation. You can change the SMTP Mail Server configuration after
installation. For more information, see 'Change SMTP Mail Server Configuration'ﬁﬂ.

i. Select Non secure in case your SMTP server does not use TLS. This is a typical

use case for mock, local mail services, for example, mailcatcher.

ii. Select Require TLS after connection if the initial connection should happen
over an unencrypted connection and then the STARTTLS command should be
used to upgrade to a secure connection. For example, Microsoft Exchange.

iii. Select Secure from the start of the connection then the app will use TLS to
connect to the SMTP server from the start. It is the most secure option, however

not all mail servers support this option.
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iv. Select Allow self-signed certificate if your mail server uses an unauthorized,
e.g., self-signed, SSL certificate.

8. Timeline Base URL and Ports Configuration

a. Enter the Base URL that hosts Timeline and via which users will be able to access
the Timeline website.
Base URL must be a fully qualified URL. The lowercase pattern is recommended.
Do not use extra spaces and forward slash '/* at the end of the base URL. It should
match the computer name on which you are installing Timeline and must be
accessible both from the computer on which the Recording Service is installed and
from the administrator browser. It also is used for links inside email messages sent
by the Timeline.

The Base URL must have the following syntax: nttp(s]://hostname:port
If you are using the default port (80 or 443), you do not need to add them to the
base URL

Examples:

The base URL of the HTTP endpoint, if a custom port is specified:
http://mytimeline.com:8080

The base URL of the HTTPS endpoint, if a custom port is specified:
https://mytimeline.com:30443

b. Specify TCP/IP port for the Timeline website.
By default, TCP/IP port 80 is used for the Timeline website. Make sure that it is not
being used by any other website. For more information, see the 'Check TCP/IP port

availability|_57'1' section. You can also set a different port number later| s,

Select Use HTTPS if you want to secure data transferred. For setting up HTTPS you
will be asking for the SSL certificate and the private key. Currently, Timeline does
not accept .pfx files. In case you have a .pfx file, you should convert it to .key and
.cert files. The key and certificate files must be named server.key and server.cert

since Timeline accepts only files with these names.

Important. If you install the program in a production environment, it is strongly
recommended to use HTTPS and highly discouraged HTTP.

9. Service Setup
Current user account is used to run the timelinepi service. If the computer is a
member of an Active Directory domain, the current domain user account will be set to
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run the service. If the computer is part of a workgroup, the local computer account
will be set. For the service to work properly, specify the valid password for the user
account used to install Timeline.

Important. It is prohibited to change the specified user account after the installation
is completed.

10.Create firewall exceptions after installation is complete
Installer does not create any software or hardware firewall exceptions. You must set
up exception settings to allow interactions between components to take place inside
a network. For example, you create inbound and outbound rules in Windows Firewall.

For detailed information, see 'Network connection settings@'.
Performing health check

Check that Timeline is working properly by doing the following:

1. Open a browser and enter {timelineURL}:{port} in the address bar, where:
{TimelineUrl} is the Base URL you specified during the Timeline installation or the
public IP address or the full name of the computer on which Timeline is installed.
{port} is a custom port assigned to Timeline website during the installation process.
If you are using the default port (80 or 443), you do not need to add them to the
{timelineURL}. By default, TCP/IP port 80 or 443 is used.

Example: http://mytimeline:8080 or https://mytimeline:30443
2. If the installation was carried out correctly, the Timeline website will open.

3. Login using the Timeline admin credentials you specified in step 4 "Admin User
Account” during the Timeline installation process 21

Upgrading Timeline

If you own ABBYY Timeline 5.1 or later, you can upgrade to ABBYY Timeline 5.3. This means that
you can install a new version of ABBYY Timeline and your databases will be maintained.

Before you begin

We recommend you backup the Timeline database. To do this, use PostgreSQL utilities. It
includes utilities that allow you to make backups. These are pg_dump/pg_dumpall and
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pg_basebackup. For detailed information, refer to

https://www.postgresql.org/docs/12/backup.html or PostgreSQL Databases Backup and

Restore[ 41 section.

Basic steps

1. Run the ABBYY-Timeline-5.3.*-installer.exe file to start the Installation Wizard.

2. Inthe program dialog box, select Update and follow the instructions of the
Installation Wizard.
Important. Upgrading within the same version is not supported.

If you can't upgrade ABBYY Timeline using the Setup, perform the following steps:
1. Uninstall your ABBYY Timeline

= |f you uninstall ABBYY Timeline 4.8, your databases are maintained while
uninstalling, but the previous settings are removed.

= |f you uninstall ABBYY Timeline 4.11 or later, you will be asked whether you want to

uninstall the product completely or maintain the databases.

2. Run the ABBYY-Timeline-5.3.*-installer.exe file and follow the on-screen

instructions in the Installation Wizard.

3. Perform a health check| 21

Uninstalling Timeline

1. Run the ABBYY-Timeline-5.3.*-installer.exe file to start the Installation Wizard.
2. In the program dialog box, click Uninstall ABBYY Timeline.

3. Inthe next dialog box specify whether you want to uninstall the product completely
or maintain the databases for future use (e.g., if you choose to install a newer

version).

= |f you want to remove the Timeline product completely, including the databases,
select Delete ABBYY Timeline database and data folder and provide PostgreSQL

superuser credentials.
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*» |f you want to uninstall the Timeline product while keeping the databases, proceed
to the next step.

4. Click Uninstall to start the removal process.
While product removal is still in progress, you have the option of canceling it by
clicking Cancel.

5. Once the product is removed from your system, click Finish to close the Installation
Wizard.

Configuring Active Directory Groups to Connect
the Recording Service with Recorders

Windows authentication is used to authorize the connection between the Recording Service and
the Recorder instances installed on users' workstations.

Make sure the computers on which Recording Service and Recorder will be installed meet the
following requirements:

e All workstations on which Recorder is to be installed and the server on which the
Recording Service will be installed must be members of the same Active Directory
domain.

e The user accounts that will be used for working with the applications have been added
into the corresponding Active Directory groups. You can use an existing security group
or create the following security groups in Active Directory:

o Recording Service admin group (e.g. Recorder-admin)
Assign this group full control to the Recording Service web application. Then add
user accounts to the group to grant them admin access to the Recording Service web
application.

o Recorder writers (e.g. Recorder-writer)
Assign this group write access to Recording Service. Then add user accounts to the
group to grant their Recorder instances write access to the Recording Service web
application. This will allow Recorder instances to send logs to Recording Service.

When installing Recording Service, in the Active Directory Security step, specify the names of
the configured groups.
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1. Admin AD Security group
Members of this group obtain admin access to the Recording Service website.

2. Recorder AD Security group
Members of this group obtain write access to the Recording Service component. Both

local and Active Directory groups and accounts can be used.

If you install the program in a production environment, it is recommended to specify existing
Active Directory security groups or groups you created before the installation, e.g., Recorder-

admin and Recorder-writer.

For testing purposes or in case you do not have Active Directory, you may specify for:
e Admin AD Security group - Recording Service local admins' user account(s)

o Domain user
Format: Domain\UserName

o Local group or user
Format: ComputerName\GroupName or ComputerName\UserName
To display the computer name, open the Command Prompt (Start > Run > cmd)
and type hostname.
Note. You may create a local group, add domain users or groups to it, and specify
this group to the Admin AD Security group field.

e Recorder AD Security group - Everyone
In this case, access to the Recording Service website will be unrestricted.
Format depends on your Windows locale, for example, in English: Everyone

How to find out which Active Directory groups in different languages you are a member of:
1. Open the Command Prompt (Start > Run > cmd)

2. Use whoami /groups
This command will list distribution groups and nesting.

You can change AD Security Groups configuration after the Recording Server and Recorder

installation. For more information, see the "How to Change AD Security Groups that Have
Access to the Recording Service Resources| e 1" section.
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ABBYY Recording Service

This section contains information about installing and removing Recording Service.

Installing Recording Service

Interactive installation
Run the ABBYY.RecordingService.<version>.exe file, select the language to run the
Installation Wizard and follow the on-screen instructions in the Installation Wizard:

1. License Agreement

Read and accept the license agreement.

2. Destination Folder and Port Configuration

Specify installation folder and TCP/IP port to be used the Recording Service website:

a. Folder path
Specify a folder where Recording Service should be installed. The default
installation folder is:
CA\inetpub\ABBYY Recording Service

b. Web site port
Specify TCP/IP port to be used by the Recording Service website or keep the
default value.
By default, the following TCP/IP ports are used:

e 443 (if use HTTPS)
For setting up HTTPS you will be asking for the SSL certificate and the private
key.

e 80 (if use HTTP)
The Default Web Site is running on port 80. If you plan to use port 80 for the
Recording Service website, you may need to modify this port from 80 to a

different one in the Internet Information Services (IIS) Manager.
Make sure that specified port is not being used by any other application. In the

event of port conflict, an alert will be displayed. Change the port number to

continue. For more information, see the 'Check TCP/IP port availability|_57'1'
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section. You can also set a different port number for the Recording Service
website later. To do this, change the port number in the Internet Information
Services (IIS) Manager.

Note: If you install the program in a production environment, it is strongly
recommended to use HTTPS and highly discouraged HTTP.

3. Active Directory Security
Windows authentication is used to authorize the connection between the Recording
Service and the Recorder instances installed on users' workstations. In the Active
Directory Security step, specify the names of the groups you configured before
installing Recording Service. Please refer to the 'Configuring Active Directory Groups

to Connect the Recording Service with Recorders[ 21 section for guidelines.
You can change AD Security Groups configuration later. For more information, see the

'How to Change AD Security Groups that Have Access to the Recording Service
Resources| s section.

4. PostgreSQL Database Options
Recording Service needs access to the PostgreSQL database. You can install
PostgreSQL on a computer along with Recording Service or a separate computer.

If you already installed PostgreSQL on another computer, select the Connect to
remote / another preinstalled version of PostgreSQL database. Otherwise, select
Install PostgreSQL on this machine.

Note. If PostgreSQL 12 is already installed on the current computer, instead of the
PostgreSQL Database Options step, the Database Connection step will open. In this
step, you need to specify the settings for connecting to the database.

a. Install PostgreSQL 12 on this machine
Allows you to install PostgreSQL and database on the local machine.
Go to the next step to specify PostgreSQL accounts and port to install PostgreSQL
locally.

i. Super user account

1. Enter the PostgreSQL superuser credentials and the PostgreSQL port number.
These credentials will be used by the installation program to create a
database user for Recording Service.

Important. The PostgreSQL superuser name may contain only English letters
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and digits from 0 to 9 and may not include any of the following characters: -

\ /%2 <> |

2. Specify TCP/IP port for PostgreSQL. By default, TCP/IP port 5432 is used.

Make sure that it is not being used by any other application. For more

information, see the 'Check TCP/IP port avaiIabiIity|_s7'T section.

ii. Service account
By default, the PostgreSQL services operate under the superuser account. To
change the default user, select Specify service user credentials option and set
new credentials for running PostgreSQL service.
Important. The Service account name may contain only English letters and
digits from 0 to 9 and may not include any of the following characters: - \ /: *?

||<>|

iii. Port
Specify CP/IP port for PostgreSQL. By default, TCP/IP port 5432 is used. Make
sure that it is not being used by any other application. For more information,

see the Check TCP/IP port availability|_57'7 section.

iv. Go to the next step to specify PostgreSQL destination folders:

1. Installation Directory
PostgreSQL will be installed into the specified folder. The default installation
folder is:
C:\Program Files\PostgreSQL\12

Important. The Installation directory must be empty.

2. Data Directory
Enter the path where the database needs to be installed.
The default path is: C\Program Files\PostgreSQL\12\data

3. Go to the next step of the Installation Wizard to specify PostgreSQL

database name and user that will work with Recording Service and database.

b. Connect to remote / another preinstalled version of PostgreSQL database
Allows you to specify connection settings to the existing database.
Go to the next step to specify database connection configuration.

During the installation of Recording Service, a shortcut to the Recording Service website is
added to the Start menu.

© 2022 ABBYY Development Inc.

32



ABBYY ® Timeline 5.3 - Deployment Guide

Important. If you are using a software or hardware firewall, make sure that the configured ports
are open in your firewall. For default network connection settings see 'Network connection
settings| s!' section.

Recording Service performance may vary depending on the hardware configuration. If you
intend to use more than 20 Recorder instances, store PostgreSQL databases partially or fully on
the SSD for better performance. For details see "How to move database tables with screenshots
to a new hard disk[ s!".

Performing health check

To perform a health check on Recording Service:

1. Go to Start menu > ABBYY Recording Service
Recording Service website will open in your browser.

2. If Recording Service has been installed correctly, you will see the Recording Service
Site with the default template.

Upgrading Recording Service

If you own Recording Service that comes along with ABBYY Timeline 5.2 or later, you can
upgrade to Recording Service comes along with ABBYY Timeline 5.3. This means that you can

install a new version of Recording Service, and your databases and logs will be maintained.
Before you begin

It is recommended that you backup your Recording Service database before you perform the
upgrade. To do this, use PostgreSQL. It includes utilities that allow you to make backups. These
are pg_dump/pg_dumpall and pg_basebackup. For detailed information, refer to

https://www.postgresql.org/docs/12/backup.html or see 'PostgreSQL Databases Backup and
Restore| 4.

Basic steps

1. Run the ABBYY.RecordingService.<version>.exe file to start the Installation Wizard.

2. Follow the instructions of the Installation Wizard.
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If you can't upgrade Recording Service using the setup, perform the following steps:

1. Uninstall your Recording Service.
Your database is maintained while uninstalling.

2. Run the ABBYY.RecordingService.<version>.exe file to start the Installation Wizard.
3. Follow the instructions of the Installation Wizard.

4. To connect to the existing database, you must provide existing values in the Database

Connection step.

a. User login and User password
Specify PostgreSQL superuser credentials.

b. Server name

Specify the server name where PostgreSQL is installed.

c. Port
Specify TCP/IP port for PostgreSQL.

5. In the Create Database step specify:

a. User to create
It is a username that will be used for interaction between Recording Service and
the PostgreSQL database.
Important. During every new installation, you must specify a new username.

b. Database name
Specify a database name. Installer will assign the database to the specified user.
Note. If you enter the name of a non-existent database, the installer will create a
new database with the specified name.

Uninstalling Recording Service

1. Open Control Panel -> Programs -> Programs and Features and select ABBYY

Recording Service.
2. Click Uninstall.

3. Inthe Installation Wizard select Uninstall and follow the instructions of the Wizard.
Note. Your database and recorded logs are maintained while uninstalling.
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How to Move Database Table with Screenshots to a
New Hard Disk

Recording Service performance may vary depending on the hardware configuration. If you
intend to use more than 20 Recorder instances, store PostgreSQL databases partially or fully on

the SSD for better performance.

Important. Only the database table with screenshots is allowed to be moved to a new hard
disk.

To do it, when the Recording Service installation or upgrade is complete, perform the following

steps:
1. Create a folder on HDD, e.g., D:\PostgresData

2. Provide full access to this folder to account is used to run PostgreSQL service.
The default account is: NT AUTHORITY\NetworkService

3. Perform as superuser the following actions on your PostgreSQL instance:

a. Register a new tablespace to define an alternative location on the file system
where the data files containing database tables and indexes will reside.
To do this, run the command:
CREATE TABLESPACE tablespace_name LOCATION 'directory’;
Example:
CREATE TABLESPACE slow_large_disk LOCATION 'D:\PostgresData’,

b. Change the Screenshot table's tablespace to the specified tablespace and move
the data file(s) associated with the table to the new tablespace.
ALTER TABLE "Screenshot" SET TABLESPACE new_tablespace;
Example:
ALTER TABLE "Screenshot" SET TABLESPACE slow_large_disk;
Note. Do not move the other tables' data files.

ABBYY Recorder

This section contains information about installing and removing Recorder.
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Installing Recorder

Before you begin

Before you begin installing Recorder, pay attention to the following:

1.

If you plan to record user activities who work using Windows RemoteApp and Citrix
Workspace App, install Recorder on a terminal server.

ABBYY Recorder can be installed on the terminal server as if it was a workstation. It
will log the actions of users connecting to this server via a Citrix client or RDP.

The user workstations installing the Recorder component, and the server hosting
Recording Service must all be members of the same Active Directory domain.

Add the accounts of users on whose computers you intend to install Recorder to the
Recorder writers Active Directory security group you configured before the

installationl =),

If the appropriate browser extensions are not installed, user activities will not be

recorded in Google Chrome, Microsoft Edge, and Mozilla Firefox.

The Firefox extension for Recorder has several limitations. For detailed information,
please refer to the "Known issues" > "Recorder Firefox extension limitationl 71"

section.

A system reboot might be needed during the Recorder installation. Please save your
work first, otherwise you may lose unsaved changes.

To install ABBYY Recorder, use one of the following methods:

e Interactive installation| s

e Command line installation| =1

Interactive installation

Run the Abbyy.Recorder.<version>.exe file, select the language to run the Installation Wizard

and follow the on-screen instructions in the Installation Wizard.

Note. ABBYY Recorder has two interface languages: English and Japanese. The Japanese

interface is only available on operating systems with the Japanese locale enabled.
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1.

License Agreement
Read and accept the license agreement.

2. Application Folders

3.

. Installation folder

Recorder will be installed into this folder. The default installation folder is:
C:\Program Files\ABBYY Recorder

. Data folder

Specify a local or network folder where the program will store its data. To keep
data in %appdata%\ABBYY\Recorder\ folder, select Use AppData folder.
Depending on the operating mode, which is set in the next installation step,
different data are stored in the specified folder:

i. When installed in Standalone mode, application logs and logs with recorded
user activity are stored there.

iil. When installed in Server managed mode, only application logs are stored
there.

Installation Details

a. Tag

You may specify a tag. Tag is simply some text string that describes the current
workstation with your Recorder instance. When installing in Server managed
mode, tag is passed to Recording Service and helps the administrator identify a
workstation in the Recording Service website. Username is not recommended as a
tag because several users could occupy the same workstation.

For example, you can specify the same tag when installing Recorder on several
workstations, e.g., the 'accounting department' tag. Then you can easily find these
workstations in the Recorders list on the Recording Service website by the
‘accounting department' tag.

. Operation mode

Select the Recorder operation mode:

i. Standalone

Standalone mode is useful for trial purposes. It has the following limitations:

= Forms is unavailable

In the 5.3 version, Task Mining obtained a fundamentally new approach to

© 2022 ABBYY Development Inc. 37



ABBYY ® Timeline 5.3 - Deployment Guide

recording and analyzing user actions - Forms. A Form is a set of subsequent
user actions in one application, window, or a web page. They are detected
automatically by the Recording Service and Timeline if Recorder installed in
the Server managed mode. In the Standalone mode forms are don't
detected.

The feature Obfuscate user data does not apply to screenshots. This means

records in text logs are encrypted, but data in screenshots aren't blurred.

Logs are not processed and not sent to Recording Service. Thus, it is
impossible to use Recording Service to review recorded data and upload
logs to ABBYY Timeline. You'll need to upload collected logs directly to
ABBYY Timeline manually. For detailed information see '"How to Upload Logs

to Timeline from a Recorder Installed in Standalone Model 71 section.

Important. Logs recorded in Standalone mode can only be uploaded to the
Task Mining 2.5 project. Since the logs recorded in this mode do not contain
information about the forms, they are not compatible with Task Mining 5.3
project and it is impossible to upload them to the 5.3 project.

When this mode is on:
» Recording control (start/stop) remains with the local computer.
» The logs with the recorded data are saved on the local computer.

= Setup installs the Recorder Log Viewer utility. The utility allows opening the

logs recorded by the Recorder installed in Standalone mode.
For detailed information on usage of Recorder Log Viewer, see 'Recorder Log
Viewer Guide".

Server managed

When this mode is on, the recording control (start/stop) can be performed from
Recording Service. User activity logs are automatically saved to the server.
Specify the URL on which Recording Service is installed and accessible over
Network.

4. Installation Option

Select browser extensions you want to install. Extensions allow Recorder to capture

user actions in the Google Chrome, Microsoft Edge and Mozilla Firefox browsers.

Note. The Recorder Firefox extension has several features. Please refer to the 'Known

issues' > 'Recorder Firefox extension limitation| 71 section for detailed information.
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After Recorder is installed on users' computers, each user must enable extensions in browser.
Below you will find instructions on how to enable the extension in Google Chromel +2} Microsoft
Edgem, and Mozilla Firefox[ )

Note. If a user has just been added to the Recorder-writer| 7] Active Directory group, you may
need to restart the computer. This allows Recorder installed in the Server managed mode to

connect to Recording Service.
Command line installation

Run the Abbyy.Recorder.<version>.exe file using the command line parameters described
below.

Silent installation

To install Recorder in silent mode, use the following command line:

Abbyy.Recorder.<version>.exe /silent

For the command-line installation, use the following command-line options:

Option Default Value Description

/silent Runs the installation in silent mode.

In the case of silent installation, no setup
dialog boxes are displayed, and the
program is installed in default

configuration.

/passive Runs the installation with the progress
bar only to be displayed. No other
dialog boxes will be displayed.

installDir=<path> C:\Program Files\ABBYY The path to the folder where Recorder
Recorder will be installed.

DataPath=<path> %appdata%\ABBYY\Recorder| Folder where the program will store its
data.
Depending on the operating mode,
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Option Default Value

Tag=<tag>

ServerUrl=<server
URL>

ChromeExt=<true| true

false>
EdgeExt=<true|false> | true

FirefoxExt=<true| true
false>

© 2022 ABBYY Development Inc.

Description

different data are stored in the specified
folder:

e If you specify ServerUrl[«1value to
install Recorder in Server managed
mode, only application logs are stored
there.

e If you install Recorder in Standalone
mode, application logs and logs with

recorded user activity are stored there.

Tag describing a current workstation. No
tag is added by default.

Turns the Server managed on. Specify
the URL where Recording Service is
installed and accessible over Network.

If this option is not specified, the default

installation is in Standalone mode.

Installs Recorder Chrome extension.

Installs Recorder Edge extension.

Installs Recorder Firefox extension.
Important.

e The Recorder setup can install the
Recorder Firefox extension only under
a current user account.
How to solve this issue see ‘Known
Issues' >_Recorder Firefox extension

limitation| 71 section.

e The Recorder setup cannot remove the
Recorder Firefox extension.

Each user must remove the Recorder
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Option Default Value Description

Firefox extension from Mozilla Firefox
manually. For more information, see
the 'How to Uninstall Recorder Firefox
Extension[ s section.

ControlButtonsVisible | true Specifies the mode where most of the
=<true|false> standard Ul is turned off.

Recorder offers a custom Ul option as an
alternative to the classic Ul It removes
the Enable/Disable buttons from the
Recorder Ul when it is installed in Server
managed mode.

Important. It is highly discouraged to
install Recorder with custom Ul in

production environment.

For detailed instructions on installing

Recorder with custom Ul, see below.

Installing Recorder with custom Ul

Recorder offers a powerful security feature that allows users to disable when Recorder is
recording their desktop activity. There are however some cases when the recording process
needs to be managed only by the administrator through Recording Service thereby preventing
the end user from turning Recorder on or off. For such cases, Recorder offers a custom Ul option
as an alternative to the classic Ul. It removes the Enable/Disable buttons from the Recorder Ul
when it is installed in Server Managed mode. To use this option, all Recorders need to be
installed in silent mode using the command line installation using the parameter
controlButtonVisible = false. The controlButtonVisible parameter specifies the mode where
most of the standard Recorder Ul is turned off, preventing the user from controlling when
Recorder is on or off.

Exarn[ﬂEIAbbyy.Recorder.<version>.exe /silent installDir="C:\Recorder" DataPath="C:\Data"

Tag="RecorderWorkstationl" ServerUrl="https://myrecordingservice.com/" FirefoxExt=false

ControlButtonsVisible=false
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This command installs Recorder to the C:\Recorder folder in Server managed mode with the
following settings:

e The Enable/Disable buttons are removed from the Recorder Ul. Only the administrator

has privileges to control the recording process through the Recording Service website.

e The Recorder Chrome and Edge extensions will be installed. The Firefox extension will
not be installed.

e Program logs will be stored in the C:\Data folder.

e Logs of user activity will be sent to Recording Service hosted at
https://myrecordingservice.com/.

How to Enable Chrome Extension

To turn on the ABBYY Recorder Chrome extension, carry out the steps listed below on the

workstations.
Important. An internet connection is required on workstations.
1. Open or restart Chrome.

2. Click the menu button, click More tools, and then click Extensions.
The Extensions page appears.

- O X
G Google x +
< C' @& googlecompwebhp?hl=en&sa=X&ved=0ah.. % ® o :
New tah Cirl+T
New window Ctrl+N
New incognito window — Ctrl+Shift+N
Goc = »
Downloads Ctrl+)
Bookmarks >
Zoom - 100%  + -
Print... Ctrl+F
Cast..,
Google Search Find... Cirl+F
Save page as.. Ctrl+5 More todls »
Create shorteut.. Ealit cut Copy Paste
Clear browsing data...  Ctrl+Shift+Del Settings
Extension Help >
Task manager Shift+Esc
Exit
Developer tools Ctrl+Shift+ i
Settings
v
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3. Find the ABBYY Recorder extension in the list and select the Enable check box.

ABBYY Recorder
% Support extension for ABBYY Recorder

Details Remove %

4. The Recorder extension is now enabled.

How to Enable Edge Extension

To turn on the ABBYY Recorder Edge extension, carry out the steps listed below on the
workstations.

Important. An internet connection is required on workstations.
1. Open Microsoft Edge.

2. Click the menu button, and then click Extensions.
The Extensions page appears.

3. Locate the ABBYY Recorder extension in the list and move the slider to On.

4. The Recorder extension is now enabled.

How to Enable Firefox Extension

To turn on the ABBYY Recorder Firefox extension, carry out the steps listed below on the
workstations.

1. Open Mozilla Firefox.
2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.
The Extensions screen appears.

4. Locate the ABBYY Recorder extension in the list and click Enable.
If the extension is not listed, it may not have been installed. How to install the
extension manually, see the 'How to install the Firefox extension in browser
ma nually|_44'1' section.
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5. The Recorder extension is now enabled.
Important. In order for the Recorder extension to works properly, the Firefox browser
and ABBYY Recorder must be run under the same account.

How to Install the Firefox Extension in Browser Manually

1. Open Mozilla Firefox.
2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.

The Extensions screen appears.

4. Press Settings (gear icon) next to the add-on search bar and select Install Add-on
From File.

5. Select %ABBYY Recorder folder%\FirefoxExtension\abbyy_recorder-*.xpi and
click Open.

6. Your Firefox browser will ask you to install the ABBYY Recorder extension right now.

7. Click Add to allow the installation.

Performing health check

Check that Recorder has been installed properly by doing the following:
e Recorder icon appeared in the system tray.

e Open your browser and make sure the ABBYY Recorder extension appeared in the
extensions list.

Upgrading Recorder

If you own ABBYY Recorder that comes along with ABBYY Timeline 5.2 or later, you can upgrade
to ABBYY Recorder comes along with ABBYY Timeline 5.3.

To upgrade ABBYY Recorder run the Abbyy.Recorder.<version>.exe file and follow the

instructions of the Installation Wizard.

During the upgrade process, the installer maintains all your previous settings.
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Uninstalling Recorder
This section contains information about removing Recorder.

Uninstalling ABBYY Recorder via the Command Line

To uninstall ABBYY Recorder in silent mode via the command line, run:

Abbyy.Recorder.<version>.exe /uninstall /silent

Important. The ABBYY Recorder setup cannot remove the ABBYY Recorder Firefox extension
from the Mozilla Firefox browser. If you have the ABBYY Recorder Firefox extension installed on
workstations, users must uninstall this extension from their Firefox browser manually. For
detailed information see 'How to Uninstall ABBYY Recorder Firefox Extensionl 1 section.

How to Uninstall ABBYY Recorder Firefox Extension

After the ABBYY Recorder uninstallation is complete, each user must remove the ABBYY

Recorder Firefox extension from Mozilla Firefox manually:
1. Open Mozilla Firefox.
2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.
The Extensions screen appears.

4. Locate the ABBYY Recorder extension in the list.

5. On the right side, click the ellipsis (3-dot) icon and select Remove from the drop-

down menu.

PostgreSQL Databases Backup and Restore

The Recording Service and Timeline databases contain valuable data. These PostgreSQL
databases should be backed up regularly. It is highly important to backup databases before
upgrading the Recording Service and Timeline applications.
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We suggest you take one of the approaches to backing up your PostgreSQL database:
e File system level backup
e SQL dump

The following is an example of backing up and restoring Recording Service databases

File System Level Backup

This backup strategy is to directly copy the files that PostgreSQL uses to store the data in the
database. We highly recommend backup your Recording Service and Timeline databases using
this method before the upgrade. You can use whatever method you prefer for doing file system
backups, but first you have to stop the Recording Service website in IIS and shut down a
database server in order to get a usable backup.

Basic Steps
1. Open Internet Information Services (1IS) Manager and stop the RecordingService
website.

2. Shut down a PostgreSQL database server

3. Copy Data Directory
The default path is: C:\Program Files\PostgreSQL\12\data
Note. If you are using SSD and HDD to store databases, copy all your PostgreSQL
data directories

4. Start PostgreSQL database server.

5. Start RecordingService website.
Restoring Files

To restore your database, you can use whatever method you prefer for doing file system restore,
but first you have to stop the Recording Service website in IIS and shut down a database server
in order to get a usable backup. For example, repeat the backup steps, but in steps 3 and 3.a
delete the current folders and replace them with the folders from the backup.
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SQL dump

The idea behind this dump method is to generate a file with SQL commands that, when fed
back to the server, will recreate the database in the same state as it was at the time of the
dump. PostgreSQL provides the utility program pg_dump for this purpose. It extracts a
PostgreSQL database into a script file or other archive file.

The approach is recommended for daily and weekly backing up.

You don't need to shut down a database server to get a usable backup. You can perform a
backup procedure from any remote host that has access to the database. But the pg_dump
utility does not operate with special permissions. In particular, it must have read access to all
tables that you want to back up, so in order to back up the entire database, you almost always
have to run it as a database superuser. If you do not have sufficient privileges to back up the

entire database, you can still back up portions of the database to which you do have access.

An important advantage of pg_dump over the previous backup method is that pg_dump's
output can generally be re-loaded into newer versions of PostgreSQL, whereas file-level
backups and continuous archiving are both extremely server-version-specific.

For detailed information, see https://www.postgresqgl.org/docs/12/app-pgdump.html.

Example of command line to run on the same computer where the Recording Service database
is installed:

"C:\Program Files\PostgreSQL\ 12\bin\pg_dump.exe" -Fd -Z 1 -U su -j 2 -f\
\fileshare\backups\august_backup RFStorage

where:
e RFStorage - the name of the database used by the Recording Service.

e su - user with sufficient rights.
Restoring the Dump

Dumps are restored using the pg_restore utility. It restores a PostgreSQL database from an
archive file created by pg_dump.

For detailed information, see https://www.postgresgl.org/docs/12/app-pgrestore.html

Example of command line to restore a dump is:
pg_restore -d RFStorage \\fileshare\backups\august_backup
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About Timeline Licenses

When installing ABBYY Timeline, the license copies to the computer on which Timeline is being
installed. Your license determines the Timeline subscription plan. You need to purchase a license
update in order to add support for new features, extend the license period, the maximum
number of users you can add to your Timeline account, or change other license parameters.

To get more information about subscription plans or purchase a license, contact your local
ABBYY sales representative or ABBYY Timeline support at support@abbyy.com.

Updating a License

1. Go to the computer on which Timeline is installed.
Note. To perform all activities below, you must be a system administrator of the

computer.

2. Stop the timelinepi service using Services snap-in or open Command Prompt as

administrator and use:

sc stop timelinepi

3. Go to the Timeline installation folder and open the license folder
The default is C:\Program Files\ABBYY Timeline\license

4. Back up existing timelinepi.lic file.
5. Replace the timelinepi.lic file with the new one.

6. Start the timelinepi service using Services snap-in or run Command Prompt as

administrator and use:

sc start timelinepi
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Administering
This section provides instructions for configuring the ABBYY Timeline components.

Using OAuth to Access Timeline

OAuth is an authorization protocol that allows granting one service (application) the right to
access user resources on another service. The protocol eliminates the need to pass the
application a username and password and allows a third-party application to gain limited

access to an application or service, on behalf of a resource owner.

For interaction between Recording Service and Timeline components, it is recommended to

register Recording Service as a client on the Timeline website.

Before you begin

Role required: admin
Basic steps

1. Register Recording Service as a client on the Timeline website and obtain credentials
(Client ID and Client Secret).

For more information, see the 'Registering a New Client on Timeline website[ 1
section below.

2. In the Recording Service website specify the authentication details to Timeline using

the credentials you obtained in step 1.

For more information, see the 'Configuring connection setting in Recording Servicel s
section below.

Registering a New OAuth Client on the Timeline website

1. Open the Timeline website and login using credentials specified during the Timeline
installationl 251

2. Go to Account Settings > OAuth tab and click Register client.
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3. In the registration form, fill in the following fields:

a. Name
Enter a unique name that identifies the application that you require OAuth access
for. For example, RecordingService.
Note. The specified name is then presented to a user in the consent screen on the

Recording Service website, make it clear to your users.

b. App URL
Enter the URL that hosts Recording Service. For example,
https://recorder.myCompany.com
Note. To get the correct App URL and Redirect URI for the Recording Service,
open the Recording Service website in your browser and go to the Settings tab.
There you will find the "Timeline Authentication Guide". Find the value you need,
copy, and paste it into the appropriate field on the Register OAuth Client form on
the Timeline website.

c. Redirect URI
Enter the callback URL that the authorization server redirects to. Enter the full URL
of the clients requesting access to the resource, appended by /api/auth/callback.
For example, https://recorder.myCompany.com/api/auth/callback

d. Confidential client
Select Confidential clients as Recording Service is able to securely authenticate
with the authorization server, for example being able to keep their registered client
secret safe.

e. Client logo
This is optional. You may upload an image to use as the application logo. The logo
appears on the approval page when you receive a request to grant a client

application access to a restricted resource on the instance.

f. Scopes
Select Read projects and Write projects scope values to request access to submit
data from Recording Service to Timeline. An application can request one or more
scopes, this information is then presented to a user in the consent screen, and the
access token issued to the application will be limited to the scopes granted.

4. Click Register and you will be able to see Client ID the auto-generated unique ID of
the application. Copy Client ID and Client Secret fields for use on Recording Service.

© 2022 ABBYY Development Inc.


https://recorder.myCompany.com

ABBYY ® Timeline 5.3 - Deployment Guide

Configuring authentication setting in Recording Service

1. Open Recording Service website you installed in the "Recording Service installation| sl
" step and login.

2. Go to the Settings > Timeline authentication and fill the fields in:

a. Timeline URL

Enter the URI of the Timeline website.

b. Client ID and Client Secret
Enter the Client ID and Client Secret you obtain after registering the client in step

4 'Registering a New Client on the Timeline website'[ =] section.

3. Click Save connection.
Please wait for notification. If the connection is successful, it displays Save. Otherwise,
an error appears: 'The server is unreachable, please notify the administrators and try
again later".
If connection fails:

a. Check the connection settings you specified above.
b. Make sure the Timeline website is available.

c. Check the firewall settings. For more information, see the '‘Network Connection
Settingsm'.

d. Make sure the ports specified during the Recording Service installation are not
being used by other applications. For more information, see the "Check TCP/IP port

availability[ s71".
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Using HTTPS

You can use HTTPS to secure data transferred between the application components and the

client’s browser.

To configure HTTPS, you need SSL certificates for Timeline and Recording Service. You can

choose one of the following options:

1. Use SSL certificate issued by the Certification Authority (CA).
This is the recommended approach for the application installation that is intended for
a production environment. The connection to the server will be secure and users will

not get any warnings from the browser.

2. Use a self-signed SSL certificate.
If you do not have a signed certificate or if you only require a certificate for testing
purposes, use a self-signed SSL certificate. However, in this case users will get
warnings from the web browser about the use of a self-signed certificate as the server
will not be considered secure.
Note. If you install the program in a production environment, it is highly discouraged
to use a self-signed SSL certificate.

Important. If you install the program in a production environment, it is strongly recommended
to use HTTPS and highly discouraged HTTP.

How to Set up HTTPS for Timeline

Below is a general sequence of steps necessary for setting up HTTPS for Timeline.

Basic steps

1. Obtain an SSL certificate.

2. Extract the certificate and keys from a .pfx file.
Currently, Timeline does not accept .pfx files. You must extract the .cert and .key files

from the .pfx file, so that the certificate and the key files are available separately.

For more information see "How to extract .cert and .key files from the .pfx@".

3. Setup HTTPS.
You can enable SSL and configure HTTPS on one of the following stages:
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= During the Timeline installation process

For more information see "How to set up HTTPS during the Timeline installationl s1

= After the Timeline installation is completed.

For more information see "How to set up HTTPS without reinstalling Timelinel ss1".

How to extract .cert and .key files from .pfx

Prerequisites. Ensure OpenSSL is installed in the server that contains the SSL certificate.

Important. Name your private key and certificate files as server.key and server.cert

respectively. The key and certificate files must be named server.key and server.cert since

Timeline accepts only files with these names.

1.

Start OpenSSL from the OpenSSL\bin folder.
Open the command prompt and go to the folder that contains your .pfx file.

Run the following command to extract the private key:
openssl pkcsl2 -in [yourfile.pfx] -nocerts -out [keyfile-encrypted.key]

You will be prompted to type the import password. Type the password that you used
to protect your keypair when you created the .pfx file. You will be prompted again to
provide a new password to protect the .key file that you are creating. Store the

password to your key file in a secure place to avoid misuse.

Run the following command to extract the certificate:

openssl pkcsl2 -in [yourfile.pfx] -clcerts -nokeys -out [certificate.cert]

Run the following command to decrypt the private key:
openssl rsa —-in [keyfile-encrypted.key] -out [keyfile-decrypted.key]

Type the password that you created to protect the private key file in the previous step.

The .cert file and the decrypted and encrypted key files are available in the path,
where you started OpenSSL.

Rename your .cert and .key files to server.cert and server.key as Timeline only

accepts files with these names.
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How to set up HTTPS during Timeline installation

1.

Run the ABBYY-Timeline-5.3.*-installer.exe file and follow the on-screen

instructions in the Installation Wizard. For more information see 'Installing Timeline| o)

Enable SSL between the remote PostgreSQL instance and application in the Database
Connection step.
If your remote PostgreSQL is configured with SSL support:

a. Choose Use SSL for the database connection.

b. Provide a path to your database SSL certificate.
If your PostgreSQL is configured with SSL support and a CA root certificate file is
used, choose Use CA Root certificate file and provide the full path to your root

certificate.

. Enable SSL between application and client in the Timeline Base URL and Ports

Configuration step:

a. Specify TCP/IP port for the Timeline website. For example, 443.

b. Choose Use HTTPS.

c. Provide paths to server.cert, server.key, and the password (if presented) files.

Setup a network connection for Timeline. For more information see 'Network

Connection Settingsm'.

a. In Windows Firewall, open the rules for inbound Timeline connections.

b. Add a TCP/IP port specified during the installation process to the exception list. For
example, 443 port.

Check whether HTTPS is functioning properly
Open a browser on any computer and enter {TimelineUrl}:{port} in the address bar,

where:

» {TimelineUrl} is the Base URL you specified during the Timeline installation|21or
the public IP address or the full name of the computer where Timeline is installed.

= {port} is the custom port assigned to the Timeline website during the installation
process. If you are using the default port (80 or 443), you do not need to add them
to the {timelineURL}. By default, TCP/IP port 80 or 443 is used.

© 2022 ABBYY Development Inc.

54



ABBYY ® Timeline 5.3 - Deployment Guide

Example: https://mytimeline:30443

How to switch from HTTP to HTTPS without reinstalling Timeline

If you did not configure HTTPS when installing Timeline, you can do it later without reinstalling
Timeline. To do this:

1. Go to the computer on which Timeline is installed.
Note: To perform all activities below, you must be a system administrator of the
computer.

2. Stop the timelinepi service using Services snap-in or open Command Prompt as
administrator and use:

sc stop timelinepi

3. Open the Timeline installation folder and copy the server.cert and server.key to ssl
subfolder.

4. By default, the Timeline website uses 443 TCP/IP port when using HTTPS.
You can reassign port numbers. For more information see "Set a Different Website
Base URL and Port Number for Timeline[ s"
Then you need to make changes to the appropriate Windows Firewall rules or to the

settings of any other firewall that you are using.

5. Make sure the HTTPS protocol is specified in the Base urt variable in the
TimelinePl.xml configuration file. Update base ur1 with a port number in case of the
custom port.

Example: BasE URL=https://mytimeline.com:30443

6. Start the timelinepi service using Services snap-in or run Command Prompt as
administrator and use:

sc start timelinepi

7. Perform a health check| )
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How to Set up HTTPS for Recording Service

Below is a general sequence of steps necessary for setting up HTTPS for Recording Service
during the installation process.

1. Obtain an SSL certificate.
The SSL certificate should be installed in Microsoft IIS on the server you plan to install

Recording Service.

2. Run the ABBYY.RecordingService.<version>.exe file and follow the on-screen
instructions in the Installation Wizard. For more information see 'Installing Recording
Service[ =T

During the Destination Folder step:
a. Choose Use HTTPS.

b. Select the SSL certificate from the list.
You can find the thumbprint of your certificate in the Internet Information
Services (11S) Manager:

i. In Connections, select the server name (host).
ii. Open Server Certificates.
iii. Open your certificate details and find Thumbprint.

3. Setup a network connection for Recording Service. For more information see 'Network
Connection Settingsl s

a. In Windows Firewall, open the rules for inbound Recording Service connections.

b. Add a TCP/IP port specified during the installation process to the exception list.
For example, 443 port.

4. Check whether HTTPS is functioning properly
To make sure that HTTPS is functioning properly, open a browser on any computer
and enter the following into the navigation bar:
https://{url}:{port}
where:
{url} is the name of the Recording Service website.
{port} is the port assigned to the Recording Service website during the installation
process. For example, 443.
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How to switch from HTTP to HTTPS without reinstalling Recording Service

If you did not configure HTTPS when installing Recording Service, you can do it later using IIS
Manager:

1. Select RecordingService site in the Connections panel.
2. Click Bindings... in the Action panel.

3. In the Site Bindings windows click Add.
The Add Site Binding windows will open.

4. Select HTTPS type and provide an SSL certificate issued to the site URL.

5. Restart the site.

Check TCP/IP port availability

If the Recording Service or Timeline website does not open after the installation is complete,
the problem may occur due to the busy TCP/IP port specified during installation.

To find open ports on a computer and to check what is using specified port, use netstat
command line:

1. Open the Command Prompt (Start > Run > cmd) and use netstat -ano | find /i
"<port_number>".
It will show you all processes that use specified port. Notice the PID (process id) in the right
column.
e -a
Displays all active connections and the TCP and UDP ports on which the computer is
listening on.

e -n
Displays active TCP connections and port numbers in numerical form.
If you want to free the port, go to Task Manager, sort by PID and close those processes.

e -0

Displays active TCP connections and includes the process ID (PID) for each connection.

© 2022 ABBYY Development Inc. 57



ABBYY ® Timeline 5.3 - Deployment Guide

Network Connection Settings

The table below lists the ports that are used by default to access Timeline components or for
interaction between components. If you are using a software or hardware firewall, make sure
that the exception settings for Timeline and Recording Service have been set up accordingly on
the computer where they installed.

If you reassign port numbers, you will need to make changes to the appropriate Windows

Firewall rules or to the settings of any other firewall that you are using.
Timeline

Timeline setup does not create any software or hardware firewall exceptions. You must set up
exception settings to allow interactions between components to take place inside a network.
For example, you create inbound and outbound rules in Windows Firewall. The table below

contains information about the ports that Timeline listens on.

Component Protocol Port Traffic Use
name type direction

Timeline TCP/IP 80 or the port|Inbound HTTP or HTTPS connections to the
used during Timeline website.

the

installation (if

use HTTP)

443 or the
port used
during the
installation (if
use HTTPS)

PostgreSQL TCP/IP 5432 Inbound Connections to the PostgreSQL
database server from the remote
computer where the Timeline is
hosted.
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Recording Service

Component Protocol Port
name type
Recording Service |TCP/IP 80

(if use HTTP)

443
(if use HTTPS)

Recording Service |TCP/IP 80
(if use HTTP)

443
(if use HTTPS)

PostgreSQL TCP/IP 5432

Traffic

direction

Inbound

Outbound

Inbound

Use

HTTP or HTTPS connections to
the Recording Service website.

¢ Connections to the
PostgreSQL database server.

e Connections to Timeline.

Connections to the PostgreSQL
database server from the
remote computer where
Recording Service is hosted.

Set a Different Website Base URL and Port

Number for Timeline

The port number used by the Timeline website is specified during the Timeline installation. By

default, TCP/IP port 80 or 443 is used for the Timeline website. You can change the port number

later using TimelinePl.xml configuration file:

1. Go to the computer on which Timeline is installed.

Note: To perform all activities below, you must be a system administrator of the

computer on which Timeline is installed.

2. Stop the timelinepi service using Services snap-in or open Command Prompt as

administrator and use:

sc stop timelinepi

To ensure the correct operation of Timeline, you need to stop timelinepi service prior

to changing the Timeline configuration file.

3. Open Command Line and use netstat -a to get a list of ports and choose an

available port.
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4. Go to the Timeline installation folder and open TimelinePl.xml file using text editor.
By default, the program is installed into C:\Program Files\ABBYY Timeline

5. In the TimelinePl.xml configuration file:

a. Find the line contains PROXY_PORT and change the value.
€.g.. <env name="PROXY_PORT" value="8080"/>
If you use a HTTPS port, change the value for the PROXY_SSL_PORT option.

€.g.. <env name="PROXY_SSL_PORT" value="30443"/>

b. Find the line contains BASE_URL and add or change the port in the value.

eg.
<env name="BASE_URL" value="https://mytimeline.com:8080"/>

or
<env name="BASE_URL" value="http://mytimeline.com:30443"/>

If you are using the default port (80 or 443), you do not need to add them to the
URL. By default, TCP/IP port 80 or 443 is used.

6. Save the TimelinePl.xml file.

7. Start the timelinepi service using Services snap-in or run Command Prompt as

administrator and use:

sc start timelinepi

Important. If you reassign port numbers, you will need to make changes to the appropriate
Windows Firewall rules or to the settings of any other firewall that you are using. Also, you will
need to make changes to BASE_URL

How to Change SMTP Mail Server Configuration
for Timeline

SMTP mail server is configured during the ABBYY Timeline installation[2¢]. You can change your
mail server settings later using TimelinePl.xml configuration file.

To change mail server configuration, perform the following actions:

1. Go to the computer on which Timeline is installed.
Note. To perform all activities below, you must be a system administrator of the
computer.

2. Stop the timelinepi service using Services snap-in or open Command Prompt as

administrator and use:

sc stop timelinepi
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To ensure the correct operation of Timeline, you need to stop timelinepi service prior
to changing the Timeline configuration file.

3. Go to the folder where Timeline is installed and open TimelinePl.xml using any text
editor.
By default, Timeline is installed into C:\Program Files\ABBYY Timeline

4. In the TimelinePl.xml configuration file find the following lines and change their

values:

a. <env name="MAIL_SERVER_HOST" value=""/>
This line contains the host of the SMTP mail server, enter the address in the value.

€.g.. <env name="MAIL_SERVER_HOST" value="example.smtp.com"/>

b. <env name="MAIL_SERVER_PORT" value=""/>
This line contains the port of the SMTP mail server, enter the port in the value.

€.g.. <env name="MAIL_SERVER_PORT" value="465"/>

c. This line contains the user that will be used to authenticate with the SMTP mail
server, enter the username in the value. Keep this value empty if your mail server

requires no authentication.
<env name="MAIL_SERVER_USERNAME" value=""/>

€.J.. <env name="MAIL_SERVER_USERNAME" value="example_user"/>

d. <env name="MAIL_SERVER_PASSWORD" value=""/>
This line contains the password of the user that will be used to authenticate with

the mail server, enter the username in the value. Keep this value empty if your mail
server requires no authentication.

€.J.. <env name="MAIL_SERVER_PASSWORD" value="example_password"/>

€. <env name="MAIL_SERVER_SECURE" value="FALSE"/>
This line contains the option whether to use TLS from the start of the connection. If

you want TLS from the start it should be TRUE otherwise it should be FALSE.
Note. It is recommended Timeline and the Exchange server use the same TLS
settings

f. <env name="MAIL_SERVER_REQUIRE_TLS" value="FALSE"/>
This line contains the option specifies whether the connection should be

established on an unencrypted channel, then upgrade to a secure connection with
a STARTTLS command. If so, specify TRUE otherwise FALSE.
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g. <env name="MAIL_SERVER_REJECT_UNAUTHORIZED" value="TRUE"/>
This line contains the option to reject unauthorized certificates, for example, self-

signed certificates. In that case, it should be TRUE. If you want to use a self-signed
certificate specify FALSE.

h. <env name="EMAIL_SENDER" value="noreply@example.com"/>
This line contains the email sender address is used to fill the 'From' header field of

e-mails.
Save the TimelinePl.xml file.

Start the timelinepi service using Services snap-in or run Command Prompt as

administrator and use:

sc start timelinepi

How to Change AD Security Groups that Have
Access to the Recording Service Resources

Active Directory security groups are configured when installing the Recording Service[ s/ You

can change groups that have full control and/or write access to Recording Service later using

the Appdata.production.json configuration file.

To change the configuration of Active Directory security groups, perform the following actions:

1.

Select the computer on which Recording Service is installed.
Important Note: To perform any of the steps below, you must be a system
administrator of the computer.

Select the folder where Recording Service is installed and open
Appdata.production.json using any text editor.
By default, the component is installed into C:\inetpub\ABBYY Recording Service.

In the Appdata.production.json file, find the ADGroupAccess section and change

the values for the UiAdmin and Recorder parameters:

"ADGroupAccess": {
"UiAdmin": "Domain\\UserName",
"Recorder": "ADGroupName"

}
Important Note: Backslashes used in values must be escaped with a backslash.

Save the Appdata.production.json file.

Restart the Recording Service website in the Internet Information Services (1IS)
Manager.
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Configuring Recording Service

Chapter contents

e Configuring and Applying Templates|_eeﬁ

e Excluding and Including Applicationsm

e Transformationsf 1]
Configuring and Applying Templates

Configure the template to specify what data needs to be logged and how it is to be processed.
To do this, open the Recording Service website and go to the Template tab. Here you can add,
change, or remove a template. A Default template is created during the Recording Service
installation process. You can add and customize new templates.

Go to the Templates tab on the Recording Service website to see basic information on
templates, review the Default template setting or add a custom template. For detailed
information on the Default template and available settings, see below. All options available in

the Default template you can set in your custom template.

Before you begin

Role required: admin

Note. If your account is not added to the Admin AD Security group specified during the
Recording Service installationm, you will not have access to the site.

Basic steps

1. Open the Recording Service website and go to Templates.

2. Click Default in the Template name column. Review and modify the options if
needed.
Note. The Default template cannot be renamed or deleted.

a. Start recording when assigned to recorder
If you need to start to record user actions after you assigned a template to a
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recorder, turn this toggle switch on.
By default, the automatic start record is disabled.

b. Record screenshots
By default, user activity and screenshots of the applications the user uses are
recorded in logs.
Screenshots will help you better understand the scenarios in which these events
occurred when analyzing the recorded events. Disable this option if you do not

need to save screenshots.

c. Record extended application info
Enable this option if you plan to export processes from Timeline for further import
and refinement in Blue Prism applications. This option allows to log additional

information required to generate a Blue Prism JSON file.

d. Obfuscate user data
This option allows to protect sensitive information and ensure data security. By
default, this option is turned on. This means records in text logs are encrypted, and
data in screenshots is blurred. If the option is disabled, you can easily read all the
texts and see data in the screenshots. To do this just go to the Logs tab and click
LogID.

e. Scheduled recording
Turn on this option to schedule recording sessions of user activity for the Recorder

instance.

f. Merge data from multiple hosts
This option allows to log a user activities in one log, if user works on multiple
computers. For example, they works on their PC, and then switches to RDP and
works there.
Note. If different tags were added during the installation to each Recorder
instances, all tags will be listed separated by commas for the resulting log. During
the logging process, the list of tags may not appear immediately, but with some
delay.
Before using this option, make sure the following conditions are met:

i. Recorder is installed on every computer a user works on and all recorder
instances display on the Recorders tab. In the Host column you can see a

computer name visible on the network within the Active Directory domain

ii. Each of the Recorder instance must be set the same template.
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g.

h.

Application list

The use Included and Excluded lists can significantly reduce the amount of
unwanted data in the project and make analyzing tasks and processes easier. This
becomes very important when dealing with large datasets that include important
events which can be made harder to understand and analyze when there are a lot
of case and path variants and deviations which are further complicated by
unnecessary data.

The default template contains a predefined excluded list[e. It includes the most
popular messengers. Correspondence in them may not be related to the tasks that
a user performs. To exclude the logging in the desired messenger, turn the
EXCLUDED LIST on and mark an item.

For details on setting up Excluded and Included lists, see the 'Excluding and
Including Applications| &Y and 'Examples| &1 sections.

Transformations

Transformations allow finding and replacing text in logs in order to redact
sensitive information, such as email addresses or IDs. This option complements the
Obfuscate user data feature. For example, transformations allow you to replace
an URL or some text in logs that should remain confidential, while obfuscation
allows you only to mask text data or blurs information in pictures.

By default, there are no transforms specified. To add transformations to the
template, add them on the Transformations tab in advance. During adding a

transformation, you must specify:

i. Regular expression
It will be used to search for the text in the recorded logs.

ii. Replacement
A string to replace the found text.

Important. Transformations added to a template are applied during the log
recording the template is assigned to. It is impossible to undo transformations.

For detailed instructions on using transformation see 'Transformations| 7'1.

3. Go to Recorders to assign the template to a recorder instance.

You will see the list of connected recorders.

a.

Check the recorder instance, you want to configure with a template and start

recording.
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The Host column displays computer names that are visible on the network in the
Active Directory domain. The Tag column displays tags added during the

installation of recorder instances.

b. Click Set Template.

In the opened list chose the template, and then click Select.

c. The recording runs automatically when the Start recording when assigned to
recorder is enabled in the template. Otherwise, click Start to run the recording.

Excluding and Including Applications

Before logs recording, application lists can be configured using the template on the Recording

Service website:
1. Open the Recording Service website and go to Templates.
2. Select a template by clicking its name.

3. In the Application list add a new item to the excluded and/or included list.
By default, user activities are recorded across all websites and desktop applications
that users interact with on their computers.
Using EXCLUDED LIST and INCLUDED LIST allows you to specify a list of websites or
applications that should be excluded and included in your logs respectively. Using
both INCLUDE and EXCLUDE lists can define a site that should be included and a
subset of that to be excluded. If the same item appears in both lists, user activities will
not be recorded across the specified application or website. The item will be
excluded from your logs.
Important. To operate correctly, the Recorder browser extension must be installed on

the user's computer.

a. To prevent the recording of user activity for a particular website or desktop
application, turn on the EXCLUDED LIST toggle switch.

b. To track and record user activity for a particular website or desktop application,
turn on the INCLUDED LIST toggle switch.

4. Click Add item.

5. Use the Add item form that will open to specify particular websites and/or desktop
applications. You can either enter a file path or URL or combine valid literal paths and
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* (asterisk) wildcard characters.

Examples:

a. Full path to the application:

C:\Program Files\ABBYY Recorder\Abbyy.Recorder.App.exe

b. Using * (asterisk) characters in the file path:

*\Abbyy.Recorder.App.exe
C:\Program Files\ABBYY*.exe

c. Using * (asterisk) characters in the URL:
https://recordingservice.abbyy.com/*

The sample URL above will prevent/allow user activities to be recorded for the

specified web pages.

https://*.abbyy.com/*

The sample URL above will prevent/allow user activities to be recorded across all

the URL's sub-domains.

6. Click Save.

Examples

The examples in the table below require the Recorder browser extensions to be installed.

Otherwise, user activities will not be recorded in Google Chrome, Microsoft Edge, and Mozilla

Firefox.

Important. If the same item appears in both lists, user activities will not be recorded across the

specified application or website. The item will be excluded from your logs.

EXCLUDED LIST INCLUDED LIST

- https://*.abbyy.com/*

https://*.abbyy.com/* |-

*\firefox.exe -

- \Chrome.exe
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Description

Records user activities in all applications, browsers, and
sites that match the https://*.abbyy.com/* template.

Records user activities in all applications and browsers with
the exception that recording is disabled for sites that match
the https: //*.abbyy.com/* template.

Records user activities in all applications and browsers
except the Firefox browser.

Records user activities only in the Google Chrome browser.
Recording is disabled for other browsers and applications.
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EXCLUDED LIST

*\firefox.exe

*\teams.exe

https://procurement.a
bbyy.ru/*

INCLUDED LIST

*\Chrome.exe,
https://*.abbyy.com/*

https://*.abbyy.com/*

*\chrome.exe,
*\firefox.exe,
*\excel.exe

https://*.abbyy.ru/*
https://abbyy.ru/*

http*, *\firefox.exe,
*\chrome.exe,
*\edge.exe

Description

Records user activities only in the Google Chrome browser
and sites that match the specified template. For example,
the following sites will be recorded: https://help.abbyy.com/
, https://www.abbyy.com/solutions/business-process/

Recording is disabled for other browsers and applications.

Records user activities in all applications and browsers
except the Firefox browser. Recording in browsers will be
carried out only for sites that match the
https://*.abbyy.com/* template.

Records user activities in the Google Chrome and Firefox
browsers, as well as Microsoft Excel. Recording is disabled
for the Microsoft Edge browser and other applications.

Records user activities in all browsers. Recording is
disabled for Microsoft Teams.

Records user activities in all applications and browsers.

Recording in browsers will be carried out only for sites that
match the https://*.abbyy.ru/* https://abbyy.ru/* templates.
Recording is disabled for the
https://procurement.abbyy.ru/* website.

Records user activities in Google Chrome, Microsoft Edge,
and Mozilla Firefox browsers. Recording is disabled for all
desktop applications.

Important. We recommend not to record messenger information, as it often contains

messages with sensitive information. Doing so can negatively affect machine performance as

well.

We recommend adding the following messengers to the Excluded list:

e Adium

e Atlassian HipChat

e Blackberry Messenger

e Brosix

e Cisco Jabber
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e Cisco Webex

Discord

Facebook Messenger

Google Hangouts

IBM Lotus Sametime

Lync

Microsoft Teams

Signal

e Skype

e Skype for Business
e Slack

e Telegram

e Viber

e WeChat

e WhatsApp

Predefined Excluded List

The Default template contains a predefined Excluded List of ignored messengers and their
websites. Enable the EXCLUDED LIST to prevent all user activities from being recorded on
specified applications and websites. By default, Excluded List is disabled. The table below lists
the applications and corresponding items in the Excluded List.

Important. The new Default template is available in Recording Service 5.2 or late installed for
the first time. When the Recording Service upgrades from earlier versions to 5.3, user settings
are maintained. This prevents unexpected impacts on processing logs. You can add listed items
to the Excluded List manually.

Applications Item in the Excluded List

Blackberry Messenger *\BBM Enterprise.exe
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Applications

Item in the Excluded List

Brosix https://web.brosix.com/*
*\Brosix.exe

Cisco Webex https://web.webex.com/
*\CiscoJabber.exe

Discord https://discord.com/channels/*

*\Discord.exe

Facebook Messenger

https://facebook.com/messages/*

*\Messenger.exe

Google Hangouts

https://mail.google.com/chat/*

https://hangouts.google.com/*

Lync *\lync.exe

Sametime *\stcommunity.exe

Signal *\Signal.exe

Skype https://web.skype.com/*
*\Skype.exe

Slack https://app.slack.com/*
*\slack.exe

Teams https://teams.microsoft.com/*
*\Teams.exe

Telegram https://web.telegram.org/*
*\Telegram.exe

Viber *\Viber.exe
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Applications Item in the Excluded List
WeChat https://web.wechat.com/*
*\WeChat.exe
WhatsApp https://web.whatsapp.com/*
*\WhatsApp.exe
Transformations

Transformations should be used in Recording Service to do the following:

1. Remove sensitive data that has been captured by Recorder as event names.
For example, if it is recorded in the log that a user has opened a document called PO-
BankOfAmerica.pdf or BillGatesSalary.xls, it is best to replace these with redacted
strings like opening PO-XXX.pdf and opening XXXsalary.xls respectively. To do so,
you will need to configure transformations as regular expressions and apply them to
selected logs.

2. Cast the names of several similar events to a common name.
If you notice similar unique strings like opening PO-BankOfAmerica and
opening PO-CitiBank, you can use transformations to convert these events to a
common type, e.g. opening new PO. This new event can then be marked as either a

start event or end event in Task Definition Editor.

For more information about creating and applying transformations, see Adding and Applying

Transformations| 711

Adding and Applying Transformations
Transformations complement the Obfuscate user data function and allow you to edit and
anonymize information in the recorded data in order to protect sensitive information.

For example, during the logging process, potentially sensitive information may appear in URLs
or event names. This data can be viewed in the Task Definition Editor after uploading the logs
to ABBYY Timeline. To hide this text from users, you can use transformations.

Important. Be careful when using transformations.
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e Transformations can greatly affect the results of automatic task definition in ABBYY

Timeline.

e Transformations cannot be undone.

Before applying transformations in production environment, complete the
following steps:

1. Record a representative sample of logs for creating and testing regular expressions.

For recording, use the Recorder instance that is installed on a user computer whose
workflow you plan to analyze using Timeline tools for further optimization. For test
purposes, it is enough to run the recording for an hour.

To do this:

. Go to the Recorders tab.

oY)

b. Select a Recorder instance.
c. Make sure the correct template is assigned to this instance.
d. Click Start.

2. Examine the data that may appear in logs and select texts that should remain
confidential. To do this:

a. Go to the Logs tab.

b. Select log and click its LogID.

© 2022 ABBYY Development Inc.

72



ABBYY ® Timeline 5.3 - Deployment Guide

c. Asa result, a window with information about the selected log will open.

ABBYY Timeline =
. € Back LoG#1  Processed &, Download  |[ Load to project W Deletelog
Recording
A
service
5/4/2022, 1:04:18 Default -
11 0h 2 min 1 2 7 AM archive(1)
Templates Events Duration Apps Forms Events 2Me
writer PETR
Recorders
Logs 05/04/2022 =

TimelneQ.imspin DA™ 5104 AM (&) FocusWindow Timelined.hmxp in DA

01:04AM (&) Press Cirl+ S ——

Transformations

Settings

01:04AM (&) Press Cirl+ Z

01:04 AM (&) Press Ctrl+Z -
Insert Text Condition

01:04 AM @ FocusWindow Insert Text Condition —

01:04 41 () SelectElement IF
helpman.exe
01:04 AM (%) Selectelement IFNOT Window
5/4/2022, 1:04:18 AM
01:04 AM () Invoke OK
Timelinehmxpin DA™ 01,04 AM (§) FocusWindow Timeline0.hmuzp in D:TI...
01:04 AM (&) Press Cirl +5S

Timeline®hmpinDATIM 1,05 AM (§) FocusWindow Timeline0.hrmuxp in DATi...

This window displays all events recorded in the current log. The selected event is
highlighted in color, and a screenshot is displayed for it, in case you have enabled
screenshot recording. The path to the application name or URL is displayed below
the screenshot.

Inspect all event names and URL text. Sometimes titles, names, addresses, and
other fragments of texts that should remain confidential may appear. In the
following step you can prepare regular expressions that will be used to find and
replace all such occurrences in the detected text and URL's.

3. Prepare regular expressions and replacement strings.

Examples:
What to look for Regular expression to Replacement string
replace
John (J|j)ohn FIRST_NAME

john.smith@abbyy.com \w+\w+@abbyy\.(com|ru) |firstlast@abbyy.com

ivan.ivanov@abbyy.ru

Customer: John Doe Customer:[\s+\w+] + Customer: Customer's Name
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4. Add transformations and test them out by applying them to one or two logs.
For details, see 'How to add a new transformation| 7! and 'Post-recording

transformation| 71 below.

5. If you are satisfied with the changes, apply the transformations to all recorded logs or
add them to the template to transform data on the fly.

How to add a new transformation

1. Go to the Transformations tab.
2. Click Add Transformation.
3. Inthe opened windows, specify the following transformation parameters:

a. Regular expression
To search for a text string, enter a regular expression using Regex syntax.

b. Replacement
To replace instances of the text string in logs with another string, enter the
replacement string.

c. Case insensitive
By default, the search is case-sensitive. If this option is selected, the search will not
be case-sensitive.

Important. If you edit or delete a transformation, the changes will propagate to all the
templates that include this transformation.

How to apply transformations

On-the-fly transformation
To apply transformations to logs while recording data, add transformations to a template and
assign it to a recorder instance.

1. Go to the Templates tab.

2. Click a template name or create a new one.

3. Click Transformations and then Add item.
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4. In the window that will open, select transformations and click Add.

5. Assign transformations to a recorder instance.
To do this:

a. Go to Recorders.

b. Check the recorder instance you want to configure with a template with a new

transformation

a. Click Set Template.
In the list that will open, click the template, and then click Select.

b. The recording runs automatically when the Start recording when assigned to

recorder is enabled in the template. Otherwise, click Start to run the recording.
Post-recording transformation
You can apply transformations to logs that have already been recorded. To do this, complete
the following steps:
1. Go to the Logs tab.
2. Select logs.
3. Click Apply transformation.

4. In the opened form, select transformation and click Apply to selected logs.

Important. If you cancel a running transformation, the transformed portion will not be undone.
Filtering Logs by a User Name

All logs are located in the Logs tab of the Recording Service website. You can find general
information for each log there. The only thing that does not display by default is the name of
the user accounts under which logs were recorded.

If you log user activity on a terminal server, all logs are recorded with the same computer name.
The same happens if several users work on the same computer. It is recommended to enable the
display of the User Name column to identify the logs for each user. This name is useful for
filtering logs by user. Further, you can load logs of different users to different Timeline projects.

To display usernames, perform the following actions:
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1. Go to the Recording Service installation folder and open
appsettings.Production.json using any text editor.
By default, it is installed into C:\inetpub\ABBYY Recording Service.
Important. Requires administrator privileges to edit appsettings.Production.json.

2. In the file add the following line:

"DiscloseOperators":"true",

3. Save the file.

4. Restart the Recording Service website in the Internet Information Services (IIS)

Manager.

5. Open the Recording Service website and go to the Logs tab.
The User Name column will be displayed there only if there are recorded logs. This
column displays the name of the user accounts under which logs were recorded.

K

ABBYY Timeline

% Apply transformation

Recording

service O logid |z Y  Recodingstart : ¥  Duration(minutes) Diskspace(MB) Version | Y  Recordedevents Tag |t ¥  Template ) ¥ | Username |: ¥ | Lastproject I: T  Processing (%)

o 1 5/4/2022, 1:04:18 AM 2 2 53 u@ writer Default - archive(1) | Petr 100 v ]

2t Templates

1 Recorders
B Logs
4 Transformations

% Settings

Upload Logs to Timeline from a Recorder

If Recorder is installed in Standalone mode, logs are not processed or sent to Recording
Service, making it impossible to use the Recording Service's tools to upload logs to ABBYY

Timeline.

Important. Logs recorded in Standalone mode can only be uploaded to the Task Mining 5.2
project. Since the logs recorded in this mode do not contain information about the forms, they

are not compatible with the Task Mining 5.3 project and it is impossible to upload them there.
To upload logs to ABBYY Timeline:

1. Open the logs folder.
By default, logs are saved to the %appdata%\ABBYY\Recorder\Recorded folder.

2. Select the folder that contains the Commands and Screenshots subfolders and
create a ZIP file. Do the same for all other folders in the logs folder.
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3. Open the ABBYY Timeline website.

4. Create a new project or open an existing one with the Task Mining — Recording
Service 5.2 and later data source enabled
(click Project > Details > Data sources and select Task Mining — Recording Service
5.2 and later).

5. Select Project > Upload data.
The Upload form will be displayed.

6. Click Browse File and select the ZIP file you created earlier.
Important! The total size of all selected ZIP files must not exceed 10 GB.

7. Click Upload.

After the upload is complete, go to the Home view (select View > Home) and define Tasks.

Background Upload of Zipped CSV Files to
Timeline

The Timeline background-upload feature involves a folder that is monitored for files copied
there. Whenever a new zip file is detected in that folder, the application grabs it and interprets
it as an uploaded archive. The folder is defined as STORAGE\sftp, where STORAGE variable in
the TimelinePl.xml configuration file.

The upload file can be copied to the specified folder by any means. It can be the target of an
SFTP upload, or it can be an otherwise shared folder.

Important. Use Deflate compression method when zipping CSV files. Otherwise, ZIP files
upload will fail. Please use archiving software that supports this method of compression. For
example, you can use 7Zip or PeaZip instead of the standard Windows archiver.

For details on configuring background upload, see the ‘Timeline User's Guide' > Automated File

Upload Via SFTP.
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Known Issues
Use this section to see if an issue affecting you is already known.

Recorder

User is using Internet Explorer 11. Is his activity recorded?

It is not recommended to record users' activity in the Internet Explorer browser. Event recording
in Internet Explorer is not fully supported, therefore events and/or screenshots may be lost
during recording.

In order to record users' activity in a web browser, use supported browsers with the Recorder

browser extensions installed.

Recorder instance installed in Server Managed mode does not display
in Recording Service

If Recorder failed to connect to Recording Service using the URL specified during the Recorder

installation, it does not display in the Recording Service web application.
To solve this issue:

1. Make sure a user account has been added to the Active Directory group you created

before the Recording Service installation[ 17\
Add a user account to the Active Directory group if you have not done it before.

2. Check the Recorder instance status on the user's computer.
If status is 'Failed to register recorder at: <SomeRecordingServiceUrl>. No such
host is known', make sure the Recording Service URL is correct. To check and/or
change URL:

a. Open settings.json
You can find it on the user's computer in the Recorder installation folder.
By default, it is installed into C:\Program Files\ABBYY Recorder.

Important! Requires administrator privileges to edit settings.json.
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b. Find the ServerManagedMode section and check the value specified in Url
parameter.
If needs, change the value and restart the ABBYY.Recorder.AutoLauncher service
using Services snap-in (Start > Settings > Control Panel > Administrative Tools
> Services).

Important. Requires administrator privileges to restart service.

Recorder Firefox extension limitation

Firefox extension install

The Recorder setup can install the Firefox extension feature only under a current user account.

If you install this feature, the Firefox browser will launch after the Recorder setup is complete.
The Firefox browser is launched under the same account as Recorder has just installed. It asks a
user to add the Firefox extension right now. User should allow the installation of the extension.

However, the Firefox extension will be unavailable for other users.

Issue. Users did not detect any new extensions in the Firefox browser as a result of your
administrative setup.

Workaround. Use one of the following methods to solve the issue:
e Add the Firefox extension manually in a user browser.

e Use the Firefox Group Policy to install the Firefox extension, for the Firefox extension
feature to be available to all users.
When installing via Group Policy, specify the path to the Firefox extension:

$ABBYY Recorder folder$\FirefoxExtension\abbyy recorder*.xpi

Contact the vendor for more info at https://github.com/mozilla/policy-
templates/blob/master/README.md#extensionsettings

Important. In case of the Recorder upgrade, the Firefox extension needs to be
updated manually.

Firefox extension uninstall

The Recorder setup cannot remove the Recorder Firefox extension.
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Each user must remove the Recorder Firefox extension from Firefox manually. See How to

Uninstall Recorder Firefox Extensionl +) for details.

After a successful Recorder installation, users did not detect the
Recorder extension in a browser, though this feature has been selected
to install

1. Make sure that the user has the Recorder extension installed in a supported
browser|_1s'1 and it is enabled. See Installing Recorder] 1 for details.

2. If a user removed the Recorder extension from a supported browser manually, then
the Recorder installer will fail to install the Recorder extension later. Contact ABBYY to

solve the issue.

Recording Service

Common Issues

1. Recording Service performance is lower if using HDD only or SSD and HDD for
storing the PostgreSQL database.

2. We do not recommend storing logs on the Recording Service server for more than a
week. After you submit logs to Timeline, you can backup logs to another server (if
necessary) and remove them from the Recording Service server.

3. After the Recording Service upgrade is complete, the list of logs on the Recording
Service website will be empty. It may take some time to display all existing logs.
Please wait a couple of minutes, and the logs will gradually come into view.

Unable to open Recording Service website using its shortcut in the
Start menu. The shortcut opens the Default Web Site.

If the Recording Service website is running on port 80, to solve this issue:
1. Open Internet Information Services (1IS) Manager

2. Find the Default Web Site and stop it.
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3. Start the RecordingService website.

Recording Service installed successfully, but an error occurred while
starting the Recording Service website:
NET :: ERR_CERT_AUTHORITY_INVALID.

If the error NET :: ERR_CERT_AUTHORITY_INVALID is displayed when you try to start the
Recording Service website, make sure you specified the correct SSL certificate when installing
Recording Service. Use Internet Information Services (IIS) Manager to do this:

1. Open Internet Information Services (1IS) Manager and select the RecordingService
website.

2. Right-click on a website, and then click Edit Bindings...

3. In the Site Bindings window, click Edit...
The Edit Site Binding window will open.

4. In the SSL certificate drop-down list, check the selected SSL certificate. Select another
one if necessary, and then click OK.
5. Restart the RecordingService website for the changes to take effect.

6. Verify the changes by opening the website in a web browser.

An error occurred while starting the Recording Service website: HTTP
Error 500.30 - ASP.NET Core app failed to start

If the error 'app failed to start' is displayed when you try to start the Recording Service website,
make sure the connection to PostgreSQL is established. Then reload the RecordingService site
in IIS Manager.

I'm trying to start a recording, but the recorder does not change the
status to "record".

A user may forbid action recording by clicking Disable in his/her Recorder menu in the system
tray. This will stop a record and block recording control on this instance via the Recording

Service Ul. The recorder continues to display on the Recording Service website in the recorders
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list. Its status is online, but the status does not change to recording after you click Start and
then Refresh List.

To start or resume recording using the Recording Service interface, the user must enable

recording by clicking the Enable button in his/her Recorder menu in the system tray.

Recording on the selected Recorder has started, but logs are not
reflected in the UL.

After you click the Start button, make sure the recording has launched. To do this click the
Refresh list button and check the recorder status changed to the recording.

Recorded events are saved to logs and sent to the server for processing. When processing is
complete, the logs are displayed on the Logs tab. New log may take some time to display in
the Recordings tab.

Logs are partially uploaded, or upload fails.

There are some limitations to upload logs:

1. Unable to upload logs, if the total number of unique events in logs exceeds 10000.
If the limit exceeds, an attempt to upload logs fails with an error: The selected logs
have more unique events than the allowed limit.

To solve this issue, reduce the number of logs being uploaded and try again.

To check the number of unique events in one log:
a. Goto Logs
b. Click logs ID and check the UNIQUE EVENTS field.

2. Logs are not fully uploaded if the size of the uploaded screenshots exceeds 25GB.
If the limit exceeds, a message appears: The size of the screenshots exceeded the
maximum limit for the selected logs. Some screenshots will not be uploaded.
This means that the text logs were uploaded completely to the ABBYY Timeline
project and image logs were partially uploaded. Screenshots outside 25GB were not
uploaded.
To solve this issue, reduce the number of logs being uploaded and try again.
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Why are there no forms in the log?

In some cases, you may open a log and the list of forms in is empty

ABBYY Timeline =
o € Back Log#l + Promsad &, Download = [ Loadtoproject = @ Obfuscatelog W Deletelog
Recording
-
service
5/4/2022,1:04:18 T te: Default-
11 0h2min NID 1 32 7 AM archive(1)
Templates i Events Duration e Apps Forms Events o Mo
o writer puter: PETR
Recorders
Logs 05/04/2022 =

Timeline0.hmp in D:ATim i - - T
T g 01:04 AM @ FocusWindow TimelineQ.hmxp in D:\Ti...

01:04AM (8) Press Ctrl+5 ——

Settings

01:04AM (B) Press Ctrl +Z

01:04AM (&) Press Ctrl+Z e =
Insert Text Condition

01:04 AM @ FocusWindow Insert Text Condition

01:04AM (E8) SelectElement IF
helpman.exe
01:04 AM () SelectElement IFNOT Elementty Window
Timestamy 5/4/2022, 1:04:18 AM
01:04AM (@) Invoke OK

Timeline.hmxpin DATIm 1.0 gy Focuswindow Timeline0.hmxp in D:\Ti....

01:04AM (&) Press Cirl +5

Timelined.hmx@in BT )05 AM (&) FocusWindow Timeline0.hmxp in DAT...

There might be a recording session in progress or forms are being detected. This process may
take some time. Forms will display when the following conditions are met:

e Form processing competed.
e There are screenshots in the log.

e The log is created using Recording Service 5.3 and later.

Note. You can upload logs to Timeline if the log status has changed to processed, the forms for

the processed part of the log will be calculated in Timeline.
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Timeline

Timeline process causes high CPU utilization after installation

You can experience a CPU load increase after Timeline installation.

The root cause of this issue is that Redis is not installed properly, and Timeline is not able to

connect to Redis. Continuous connection attempts are causing high CPU utilization.

Important. To prevent this issue, you have to be an Administrator on the target machine and
have enough permissions to install Ubuntu on Windows Subsystem for Linux. For proper Ubuntu

installation please run the installation file as Administrator.
To solve this issue:

1. Stop the timelinepi service from services.msc or open the command prompt as
Administrator and execute the following command:

sc stop timelinepi

2. Open PowerShell as Administrator and list all the WSL installations in your Windows

system executing the following command:
wslconfig /1

Find Ubuntu (or Ubuntu-20.04) in the list and unregister the distribution executing
one of the commands below, depending on the name in the list:

wslconfig /u Ubuntu
wslconfig /u Ubuntu-20.04

3. Open Windows Explorer, then navigate to the Ubuntu Installation Folder[ ] which
you have selected for Ubuntu during the Timeline installation. The default folder is C:
\Program Files (x86)\Ubuntu

4. Run the run ubuntu.exe (or ubuntu2004.exe) file as administrator and follow the

instructions on the screen to install.

5. Once the installation is done, run ubuntu.exe (or ubuntu2004.exe) to open Ubuntu
and login as sudo user by executing the command:

sudo su

6. In Ubuntu Terminal navigate to the Source Folder where you originally downloaded
the distribution and which you have specified when installing Timeline.

7. Execute the commands below to install and start Redis:
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d. dpkg -i redis-tools 6.2.4-1lrll~focall amd64.deb
b. dpkg -i redis-server 6.2.4-1rll~focall amd64.deb

C. service redis-server start

You can test that your Redis server is running by connecting to the Redis CLI:
redis-cli
127.0.0.1:6379> ping

8. Start the Timeline service either from services.msc or executing the following
command in the command prompt:

sc start timelinepi
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Technical Support

Should you have any questions regarding the use of ABBYY Timeline, please e-mail the ABBYY
technical support service at support@abbyy.com. Please provide the following information
when contacting technical support:

e your first and last name.

e the name of your organization.

e your phone number (or fax, or e-mail).

e your ABBYY Timeline version and the build number.

e a description of the problem and the full text of the error message (if there was any).
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